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1 Preface 

It is recommended that users have gone through the documents in the resource kit, which provides an 

overview on the requirements and the importance of preparing an IFC model for submission to Corenet X; 

Step 0) How to Learn IFC-SG, 

Step 1) IFC 101, 

Step 2) Industry Mappings, 

Step 3) Configurations (respective BIM Authoring Tool) 

Users may refer to Step 4) Exercise on IFC Key Data Structure to verify their understanding when they have 

completed all the steps above.
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2 Introduction 

IFC-SG aims to adopt the international Industry Foundation Classes (IFC) standard as the base for the 

common representation for BIM submission. IFC is a standardized, digital description of the built asset 

industry. It is an open, international standard (ISO 16739-1:2018 ) and promotes vendor-neutral, or agnostic, 

and usable capabilities across a wide range of hardware devices, software platforms, and interfaces for many 

different use cases. 

This document is intended as a reference for the users in preparing BIM files for submission in IFC-SG. It 

contains software configuration setup, export settings, and IFC-SG-specific concepts used to map the native 

information for the applicable IFC-SG export. 

2.1  UNDERSTANDING IFC-SG 

With IFC being a semantically rich data structure, IFC Concepts are captured and used to map objects 

for IFC-SG. The building elements listed in the IFC-SG BIM Objects Dictionary are derived from various 

regulatory handbooks that are mapped in the early stage of IFC-SG. These objects are any physical 

elements referred to as BIM concepts such as walls, doors, and windows, and non-physical elements 

such as building containers, space, properties, and material information. IFC Concepts provide another 

level of identifying what an object is. IFC concepts are 

• Standard IFC entities and types, 

• predefined type enumeration, and 

• IFC standard property set(s). 

When no directly appropriate entity, predefined type, or property set is found, standard extension using 

USERDEFINED ObjectTypes and USERDEFINED PropertySets “SGPset_” is used 

2.2  IFC4 REFERENCE VIEW 

IFC-SG is mapped using IFC4 Reference View, which is currently the broadest proliferation of IFC BIM 

data across many software application types supporting different communication and collaboration 

workflows.  

IFC4 Reference View is particularly suitable for all BIM workflows that are based on reference models, 

where the exchange is mainly one-directional, similar to the workflow defined for the exchange in 

requirements in IFC-SG. 

2.3 IFC-SG AS A MODEL VIEW DEFINITION 

IFC-SG is like what an Model View Definition (MVD) does. It is only a subset of requirement definition 

from the overall IFC schema to describe data exchange for a specific use or workflow. Mainly, it narrows 

down the scope of the IFC schema to one that will be used as an exchange requirement for the local 

building plans submission using a neutral format.  

https://www.iso.org/standard/70303.html
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3 Autodesk Revit 

3.1 GENERAL BIM GUIDE 

Note: It is preferrable that users refer to the original guide from authoring tool 

—Revit IFC Manual 

https://damassets.autodesk.net/content/dam/autodesk/www/pdfs/revit-ifc-guide-high-res.pdf 

 

3.1.1 How to Use BIM Interoperability Tools for Revit 

1. Install BIM Interoperability Tools for Revit. 

 

 

 

 

 

 

BIM Interoperability Tools 

Note: To use IFC Classification Manager for Revit, User must install the BIM Interoperability 

Tools as an Add-in. 

https://www.biminteroperabilitytools.com/classificationmanager.php 

 

BIM interoperability tools can be accessed via the Autodesk desktop app as well. 

  

https://damassets.autodesk.net/content/dam/autodesk/www/pdfs/revit-ifc-guide-high-res.pdf
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2. After the installation, under BIM Interoperability Tools Ribbon Tab, in Standardized Data Panel, 

select Setup to upload the Revit Classification excel sheet. 

 

BIM Interoperability Setup 

3.1.2 How to Add a Shared Project Parameter 

1. To add a Project Parameter simply go to the Manage Ribbon Tab, under Settings Panel select 

Project Parameters. 

 

Project Parameter from Manage Tab 

2. After selecting Project Parameters dialog box, click Add to proceed adding a parameter. 

 

Add Parameter 

3. In the Parameter Properties dialog, under Parameter Type, select Shared parameter, and click 

Select.  

 

Shared Parameter as Parameter Type 
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4. In the Shared Parameter dialog, select the appropriate and click ok. 

 

Shared Parameter as Parameter Type 

5. Click Edit to display the edit shared parameters dialog box.  

 

Select "Edit" 

6. From this dialog, users can open a different shared parameter file or add new parameters.  
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7. Click Browse to preload the configured shared parameter file.  

 

Select "Browse" 

 

8. Look for IFC-SG Shared Parameter.txt file in the IFC-SG Resource Kit> Step 3) Revit>01) 

Setting up Revit Tool folder, select and then open. 

 

9. After opening the .txt file, the window will look like the reference image below.  

 

.txt File Loaded Successfully 
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10. Advance users to note 

a. For advance users who will be merging the IFC-SG Shared Parameters into existing 

company’s shared parameter, use text editor tools such as notepad++ or excel, save 

the file as delimited (Tabs) .txt file. 

b. To manage the merge, and do take note of the following: 

i. Ensure there is no duplicate parameter name  

ii. For duplicate parameter names, ensure that the Revit GUID of the shared 

parameter (for parameter of similar name) follows the IFC-SG shared 

parameter, and remove the older parameter. 

c. Revit Schedule will not work be able to list the values of parameters of the same name 

but with different Revit GUID. 
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11. Find the parameter to be added. Search for the parameter manually or enter the parameter. 

 

Select the Proper Property 

 

12. Under Parameter Data, set the parameter selected to Instance and group parameters to IFC 

Parameters. 

Do not forget to check the target object's category to make sure it's correct. (In this case, the 

Walls is a category), click OK. 

 

Adding property into object category 
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13. To confirm the added parameters, select the target object, look for IFC Parameters in 

Properties. 

 

Property Successfully Added into the Object 
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3.1.3 How to Apply Predefined Type (For Revit 2022 and before) 

1. Predefined type can be added manually or through BIM Interoperability tools. In this example, 

BIM Interoperability has been used.  

2. Before assigning in any object using BIM Interoperability tools, the Description Parameter (for 

example in picture below “IfcExportAs”) should be pre-created under IFC Parameters group. 

 

Pre-created IfcExportAs under IFC Parameter Group 

3. Select the object to classify, go to BIM Interoperability Tools Ribbon Tab in the Standardized 

Data Panel, and select Assign Picklist. 

 
 

Standardized Data under BIM Interoperability Tools, choose "Assign Picklist" 
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4. Under Elements (for classifying objects), select the version of IFC Class Mappings 4.1, and 

set the Filter at Any. 

 

Classifying object under IFC Class Mapping 4.1 

5. Then type and search the object and choose the predefined type value. After that, click Assign 

and close the window. After assigning make sure to go back to the selected object and verify 

the input.   

 

Assigning Predefined Type 
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6. The object must already be assigned and categorized in the Properties/IFC Parameters. 

 

Assigned Predefined Type  
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3.1.4 How to apply Predefined Type (Revit 2023 and newer) 

1. For Revit 2023 and newer, populate the built-in “Export to IFC As” parameter right from the 

property palette, ignoring the “IfcExportAs” parameter. 

 

Using Export to IFC As and Ignoring IfcExportAs for R23 and newer 

2. Click the options (3 dots icon) to open the IFC Entity Selector. 

 

Open up IFC Entity Selector 

3. Pick and choose the Entity and its Predefined Type as shown and select “Ok” 

 

Assign Predefined Type  

 

  

Entity 

Predefined Type 
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3.1.5 How to Apply Userdefined Type 

1. To assign userdefined-predefined type using BIM Interoperability Tools, simply assign the 

selected object to its USERDEFINED. In this case, IfcTankType.USERDEFINED. 

 

For Userdefined Object Type 

2. If the object is userdefined, type and search under IfcObjectType. And again, Description 

Parameter (IfcObjectType) should be pre-created before assigning. 

 

 

Adding the Value for Userdefined Object Type 

  

Note: Every userdefined-predefined object 
there should be a corresponding IfcObjectType 
value. 
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3.1.6 Using Revit Schedule to populate Object Types for IfcExportAs and IfcObjectType 

The Revit Schedule feature will allow an overview of the information within a Family. In the below 
example, a Structural Framing Schedule was created to view on what information the IfcBeam been 
assigned, and the BIM Interoperability Tool was used to quickly assign values to “IfcExportAs” and 
“IfcObjectType” 

 

Assigning predefined types to “IfcExportAs” 

 

 

Assigning “USERDEFINED” to “IfcExportAs” and “PRESTRESSED_BEAM” to “IfcObjectType”  

as the object type was not part of the predefined enumeration in IfcBeam. 
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3.1.7 IFC Export Setup 

1. When exporting the file, make sure that the current setup is the correct format. To check this, 

click Modify setup.   

 

Modify Setup under Export IFC 

2. User can load the JSON files from the provided files, depending on the version of Revit the 

user is using. The JSON file would have presented all the needed settings for export to IFC-

SG, users will only need to follow Step 6, to browse the local directory for the property mapping 

file. 

 
 

 

 

Loading of JSON File 
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3. If these settings are not available/ not usable for specific version, the user can manually apply 

these settings. 

Click create new format and name the new export setup. 

 

Creating new Export Setup for Revit2022 

4. Select the created setup, go to the General tab, copy the highlighted details and click Project 

Address to change the desired location. 

 

Setup under General 

5. After entering the Project Address, go to the next tab, Additional Content, select all the boxes, 

and then go to the next tab.  

 

Setup under Additional Content 
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6. After the Additional Content, go to the Property Set and enable the following options in the 

image below.  

 

Setup under Property Sets 

 

7. To load the IFC-SG Property Mapping Export file, select browse on the Property Sets tab and 

select the IFC-SG Property Mapping Export.txt file.  

  

Adding the File for Export Userdefined Property Sets 
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8. After loading into the SGPset, proceed to the Level of Detail tab. Set the “Level of Detail for 

some element geometry” to Low. Then proceed to Advanced tab. 

 

Setup for Level of Detail 

9. Finally, on the Advanced tab, select the Use active view when creating geometry, IFCSITE, 

IFC GUID and the Tessellated Geometry. Then go back to all the tabs to see if something 

missed out and if everything was set up correctly, then click OK. 

 

 

Setup for Advanced 
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For the Revit 2021 users, the IFC Export Settings are as follows: 

1. The user can load the JSON file from the file provided according to the version. 

  

Setup for Revit 2021 

2. Select the created setup, go to the General tab, copy the highlighted details and click Project 

Address to change the desired location. 

  

Setup under General 

3. After entering the Project Address, go to the next tab, Additional Content, select all the options, 

and then go to the next tab. 

 

Setup under Additional Content 
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4. After the Additional Content, go to the Property Set and enable the following features in the 

image below. 

 

Setup under Property Sets 

5. To load the IFC-SG Property Mapping Export file, select browse on the Property Sets tab and 

select the IFC-SG Property Mapping Export.txt file. 

 

 

Adding the File for Export Userdefined Property Sets 
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6. After loading in the SGPset, proceed to the Level of Detail tab. Set the Level of Detail for some 

element geometry to Low. Then proceed to Advanced tab. 

 

Setup for Level of Detail 

7. Finally, on the Advanced tab, select the Use active view when creating geometry, IFCSITE, 

IFC GUID and the Tessellated Geometry. Then go back to all the tabs to see if something 

missed out and if everything was set up correctly, then click OK. 

 

 

Setup for Advanced 
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For the Revit 2020 users, the IFC Export Settings are as follows: 

1. The user can load the JSON file from the file provided according to the version. 

  

Setup for Revit 2020 

2. Select the created setup, go to the General tab, copy the highlighted details and click Project 

Address to change the desired location. 

  

Setup under General 

3. After entering the Project Address, go to the next tab, Additional Content, select all the boxes, 

and then go to the next tab. 

 

Setup under Additional Content 
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4. After the Additional Content, go to the Property Set and copy and follow this format. 

 

Setup under Property Sets 

5. To load the SGPset .txt file, select browse on the Property Sets tab and select the SGPset file. 

 

Adding the File for Export Userdefined Property Sets 

6. After loading into the SGPset, proceed to the Level of Detail tab. Set the Level of Detail for 

some element geometry to Low. Then proceed to Advanced tab. 

 

Setup for Level of Detail 

  



P a g e  28 | 77 

 

 

7. Finally, on the Advanced tab, select the Use active view when creating geometry, IFCSITE, 

IFC GUID and the Tessellated Geometry. Then go back to all the tabs to see if something 

missed out and if everything was set up correctly, then click OK. 

 

Setup for Advanced 
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3.1.8 IFC Installation Guide 

There are 2 means of updating the built-in IFC exporter to its latest release, either a) automatically via the 
Autodesk desktop application, or b) through manually downloading the latest release for respective Revit 
versions (eg. Revit 2022, 2023, etc…) through the GitHub releases page. 

It is recommended to perform IFC exporter updates through the desktop application whenever possible and 
to only use the GitHub method (b) if the updating through the desktop application fails. 

1. Before performing any updates to the IFC exporter, please check if there was an earlier version 

of the IFC exporter installed.  

2. To check the current version of IFC exporter installed, click on the windows icon and then type 

“Add or remove program”. 

 

IFC Exporter from System Programs 

3. Uninstall the previous versions of Revit IFC exporter before proceeding to install the latest 

release of Revit IFC Exporter. 

 

Uninstall the older version of Revit IFC Exporter 

 

 

a) Through the Autodesk desktop application. 
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1. Launch the Autodesk desktop application through searching for the application from the the 

windows home menu, or through the shortcut located in the taskbar. 

 

  

Launching the Autodesk Desktop Application 

 

2. Once launched, navigate to the Revit tab on the left to check for any new releases for the 

relevant Revit versions and to click on the corresponding update button, to the latest version 

available. 

 

Updating of IFC Exporter Version 
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b) Though GitHub 

 
When installing the Revit IFC Exporter, check for the latest Releases at the following link: 
https://github.com/Autodesk/revit-ifc/releases 

 

In this example, download the Revit 2022 IFC Exporter.  

3. Click on the Releases to check for a latest release update.  

4. Under Assets, download the .msi file. 

 

Revit IFC Exporter 

 

5. Start installing the latest release of the Revit exporter.  

 

 

Installing the latest Revit IFC Exporter 

 

  

https://github.com/Autodesk/revit-ifc/releases
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6. Click Next to continue installing, tick the ‘I accept’ message, then click Next… 

 

‘   

Installing setup 

7. Click Next after verifying the location of the destination folder. Then click Install. 

  

Install the latest Revit IFC Exporter 

8. Click finish. If the installation is done correctly, it will redirect to a link of the Revit IFC 2022.   

  

Installed successfully 
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9. Verify if the installed Revit IFC exporter has the version 22.4.0.0 by clicking the Version History. 

  

Verified Revit IFC Exporter version in the link 

 

10. Check also in the windows under Apps & features if the installed IFC Exporter is the latest 

version. 

 

Verified Revit IFC Exporter version in windows installed 
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3.1.9 IfcMapConversion 

1. When dealing with the exact origin of the BIM, IfcMapConversion allows local engineering 

coordinate system to its place within the map by specifying its datum within the model. To 

specify the datum simply go to File Ribbon Tab select Export then click IFC. 

 

Select IFC under Export 

2. Select “Modify setup …” 

 

Modify Setup 
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3. Select the preferred Coordinate Base, note that the origin of the coordinate base must be 

specify first so it will reflect in the exported file (refer to step 5-4). In this example Project Base 

Point is used as Coordinate Base.  

 

Project Base Point as Coordinate Base 

 

4. Below is the origin of the Coordinate Base within the tool UI which will be the reference of the 

projected coordinate base system. 

 

Coordinate Base 
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5. After specifying and setting the origin of the Coordinate Base, under Projected Coordinate 

System Reference fill the EPSG Code with “EPSG:3414”, notice also that the Eastings and 

Northings were replicates of the specified data of Coordinate Base. 

 

EPSG Code Value, Eastings and Northings 

6. Name, Description and Geodetic Datum shall be automatically filled after EPSG Code was 

specified. See below example 

 

EPSG Code was successful, Information will be automatically loaded into the System 

7. Make sure to follow the IFC Export Setup Steps (refer to section 5/page number 16) to have 

correct result. 
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3.1.10 IfcMaterial/IfcMaterialLayer 

Applying for materials in Revit has many ways. It can be applied thru system families, loadable 

families and in-place families.  

First, the system families: 

8. Pick the wall > Click Edit Type > Click Edit Structure 

 

After clicking Edit Structure, click the 3 dots and can now edit the materials needed.  
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9. Ensure material of objects were selected in dialog box as shown below. Then click Ok.  

 

 

Second, the loadable families: 

Component basically allows to insert any families that are not regular system families in Revit, so this 

are the component family.  

 When loading a component, go to Architecture tab > on the Build tab, click Component > then click 

Place a Component, then choose the loadable family 
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 Pick the family > Click Edit Type > See to it, there is a material option which can be changed. 

Let’s say the top material, body material, handle/leg material.  

 

 For example, click the 3 dots… 
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10. Ensure material of objects were selected in dialog box as shown below. Then click Ok.  

 

 

Third, In-place families: 

Component basically allows to insert any families that are not regular system families in Revit, so this 

are the component family.  

When loading a component, go to Architecture tab > on the Build tab, then click Model In-Place, then 
create an In-place family  
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After creating, Click the In-Place Model > Click Edit In-Place >  

 

 

 

Under the Materials and Finishes, click the 3 dots in the Material property 

 

 

 

 

 

  



P a g e  42 | 77 

 

 

Ensure material of In-place model were selected in dialog box as shown below. Then click Ok.  

 

 When the chosen material has been reflected on the material property, Click Finish Model 

 

 

 

 

 

  



P a g e  43 | 77 

 

 

In addition, another way of putting materials in Revit is in the Piping System Material. 

1. When editing the piping material, click the Pipe > then click the Piping System tab 

  

 

2. After clicking the Piping System tab, see to it that the Piping System Name is already set, then click Edit 

Type. On the Type Properties, click the 3 dots under the material property to set the desired material. 
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3. Ensure material of objects were selected in dialog box as shown below. Then click Ok.  

 

 

These are now the exported file with the If Material/IfcMaterialLayer 

 

 

3.2 REVIT SUPPORTED IFC CLASSES 

https://help.autodesk.com/view/RVT/2022/ENU/?guid=GUID-EE6C0CF8-7671-4DCC-B0C7-EEA7513C90A9 

  

https://help.autodesk.com/view/RVT/2022/ENU/?guid=GUID-EE6C0CF8-7671-4DCC-B0C7-EEA7513C90A9
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4 IFC-SG (Singapore specific requirements for Building Regulatory 

Submission) 

Do note that BIM representations as stated in the document are for reference and not prescriptive, i.e. industry 
can continue to use their own object libraries and BIM tools as long as the IFC information that was exported is 
aligned with the Regulatory Requirements. 

4.1 AREA, OBJECT AND ROOM DEMARCATION 

1. Select Area Plan under Room & Area Ribbon Tab in Architecture tab > choose Type where to create 

the view > choose IFC SG > 

 

 

Setting up Area Plan 

2. Click the Area Boundary > choose the rectangle line to pick the 2 opposite corners.  

 

 

Area Boundary 
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3. Select Area > then click inside the Area that have created the boundary. 

 

 

Creating an Area 

4. Click the Area and it could be identified by the input on the IfcExportAs into (For example: 

IfcSpatialZoneType.FIRESAFETY) 

 

 

Input Value on the Area Zone 
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4.2 DOOR PROPERTIESExporting IfcDoorLining Properties 

1. When exporting door lining properties, the first thing to do is assign the project properties. Go 

to Manage ribbon tab, go to the Settings panel and select Project Parameters. 

 

Project Parameters under Manage Tab 

 

2. Select Add, and under Parameter Type, select Shared parameter > Select 

 

Add Parameter and Select Shared Parameter as Parameter Properties 

3. Select IFC Properties as the parameter group and look for the door lining properties. In this 

case, ThresholdThickness is the property of the selected door lining. Select it and then OK.  

 

Adding the ThresholdThickness  
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4. After selecting door lining property, let the group parameter under be retained then move 

and select the door as a category. 

 

Adding the Property to the Category 

5. Once the door lining properties have been added, they will be displayed in the project 

parameter panel. Click OK to complete the added parameter and see it in the identified 

component. 

 

Adding the Property Successfully 

6. Find the group parameter to which the property will be added. In this example, the selected 

door has a property whose group property is below the dimension. Add that value to the door 

panel properties, export it and validate it. 

 

Lining Property under the Dimension 
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4.2.2 Exporting IfcDoor OperationType 

1. In general, the OperationType parameter is native to the Door family. To specify a specific 

operation type, select the Door object, then go to Edit Type 

 

Edit Type Under the Object Properties 

2. Under Type Parameters, go to IFC Parameters and specify a value for Operation, once 

specified, click Apply and then OK. 

 

Adding Property Operation Type under IFC Parameters 

**note: Below is the list of Door Operation Type which can be used and exported. 
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4.2.3 List of Basic Door Operation Type 

 

BIM Representation Operation Type 

Door 

• Door Style 
o Operation  

 

1. SINGLE_SWING_LEFT 

2. SINGLE_SWING_RIGHT 

3. DOUBLE_DOOR_SINGLE_SWING 

4. DOUBLE_DOOR_SINGLE_SWING_OPPOSITE_LEFT 

5. DOUBLE_DOOR_SINGLE_SWING_OPPOSITE_RIGHT 

6. DOUBLE_SWING_LEFT 

7. DOUBLE_SWING_RIGHT 

8. DOUBLE_DOOR_DOUBLE_SWING 

9. SLIDING_TO_LEFT 
10. SLIDING_TO_RIGHT 
11. DOUBLE_DOOR_SLIDING 
12. FOLDING_TO_LEFT 
13. FOLDING_TO_RIGHT 
14. DOUBLE_DOOR_FOLDING 
15. REVOLVING 
16. ROLLINGUP 
17. SWING_FIXED_LEFT 
18. SWING_FIXED_RIGHT 

 

Basic Door Operation Type 
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5 Advanced Users 

5.1 MODIFYING CONFIGURATION FILES 

5.1.1 Property Sets 

1. Below is a sample copy of the IFC-SG Revit configuration file used during the export. 

2. Before exporting, make sure all required IFC4 (USERDEFINED), IFC-SG PropertyName are 

present. If not, add a property and save the updated version.  

 

Compilation of Userdefined Property Set 
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5.1.2 Shared Parameters 

1. Group the properties based on the Domain. Groups were divided into three domains: IFC-SG 

ARC, IFC-SG MEP, IFC-SG STR. IFC-SG COMMON was added for all other properties that 

are common to the three domains.  

 

Property Group divided by Property Domain 
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5.1.3 Revit Classification Manager 

1. This Revit Classification Manager is used for BIM Interoperability. This is a Microsoft excel file 

that needs to be uploaded to the Revit tool. The following is an overview of the excel file. 

 

Sample view of Revit Classification Manager used in BIM Interoperability. 
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5.2 ADDITIONAL HOW-TO MODEL GUIDES 

5.2.1 How-to Model IfcGrid 

For you to export the IfcGrid, create the grid by using Structural Template in Revit when starting a project.   

1. After creating a new project, choose the Structural Template. 

 

 
 

Creating New Project    Structural Template File 
 

2. Under Structure ribbon tab, in Datum panel, click Grid and start creating grid. 

 

  
Placing Grid 

 

 
Creating Grid 

 

  



P a g e  55 | 77 

 

 

3. To export it based on the IFC Export Setup Steps (refer to section 5 /page number 15) to have 

correct result. 

 
IfcGrid is Exported 
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5.2.2 Missing Door lining Properties How to Model 

In Revit, the default door has no available IfcDoorLiningProperties. To add the Door Lining and Door Panel 
Properties, some configurations are required.  
 

1. Create new family with the default template. 

 
Create a new family. Use the Metric – Door default Autodesk template. 

 

 
Creating New Door Family 

 
 

This door family template is made for a residential wooden door family by default.  
When creating a parametric door with door lining properties and door panel properties, 
delete a few elements that is not much needed. Go to the plan view. Delete the unnecessary 
elements. 

 
Delete Trim Elements 

 

 
Delete Dimensions & Swing Door Reference 
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2. Create rough dimensions reference planes 

 

 

Create a Rough Dimensions Reference Planes 
 
 
 

3. Start Creating the parametric door with all the dimensions of the parameter properties needed 

for door lining and door panel. 

 
 

 
Parametric Door with Dimensions 

 
 
 
 
 
 
 
 
 
 

 
 

 

 



P a g e  58 | 77 

 

 

4. Assign in each dimension, the parameter properties. 

Click on the dimension, then click create parameter icon. Create the parameter name, then 
click Ok.  

 

 
Assigning Parameter Name in Each Dimension 

 

4. Provide all the necessary parametric properties. 

 

 
 

Provide all the Parameter Properties 
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5. After assigning all the parameter properties, check the properties in the ‘Family Type’ panel 

under Modify tab.  

 

 
Family Types Tab 

 

 
 

Family Types Properties 
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6. To export it based on the IFC Export Setup Steps (refer to section 5 /page number 15) to have 

correct result. 

 
 

Upon Exporting Value becomes 0 on the Threshold Thickness and Transom Thickness 
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5.3 HOW-TO ADD DISTRIBUTION SYSTEM INFORMATION IN PIPING SYSTEM 

When adding Distribution System Information in Piping System in Revit MEP, do not just click on 
pipes and add the Predefined/Userdefined property value. Or else, it will export into IfcPipeSegment 
instead of IfcDistributionSystem. 

Before assigning IfcDistributionSystem, “IfcExportAs” and “IfcObjectType” should be pre-created 

under IFC Parameters group and assign to the Piping System Group. 

7. On the View Tab > Drop down the User Interface Tab > Check the System Browser to show 

the IfcDistributionSystem in the model 

 

Location of System Browser 

 

8. Go to the 3D View > Go to the System Browser > Select a System > It will automatically highlight 

the piping system > When in Modify|Piping System tab > Modify the Predefined/ Userdefined 

properties under Ifc Parameters 

 

Modifying Predefined Property of Piping System 

 
 

 

Modifying Userdefined Property of Piping System 
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9. Make sure the property type name is correct in the specific use.  

Click “Edit Type” and duplicate if need to change the property type name > then click Ok.  

 

Editing Type Properties 
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10. To export it based on the IFC Export Setup Steps (refer to section 5 /page number 15) to have 

correct result. 

Here is the sample result generated using Revit 2022 IFC exporter.  

The system gets the value for the Predefined Type of the value of Object Type 

 

Exported Predefined Type 
 
 

Note: If the system has predefined type value in the IFC4 documentation, even if the user defines it to 
a userdefined type, its predefined type value will be generated. 

 
 
 
 
 

 

Exported Userdefined Type 
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11.  For Revit 2021 and below, IFC4 Entity to be represented as "IfcSystem. 

 

Exported IFCSYSTEM Element Type in Revit 2021 
 
 
 
 
 
 

When applying the mapping in the BIM authoring tools, character limits in user-defined property sets, property 

names, and values were encountered. QA testers had documented these issues and made them available 

to both the mapping team and BIM team in case properties appeared to exceed the character limit. 

Additionally, the character limit issue was brought to the GovTech team's attention, to highlight to the relevant 

agencies and seek feedback from the representatives regarding how the property names would be amended 

to. 
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5.4 HOW-TO ADD BUILDING SYSTEM INFORMATION  

When adding Building System Information in Revit, ensure “IfcExportAs” and “IfcObjectType” 
should be pre-created under IFC Parameters group and assigned to Model Groups. 

 

1. When creating a building system, the individual elements are to be combined into model groups 

to for assignment to IfcBuildingSystem as its IFC representation. Select the individual elements 

modelled for the purpose > Head to file Tab > Select “Create Group” > Input in the name of the 

Model group in the dialog popup box.  

 

 

2. Once grouped, select the Model group > Modify the Predefined/ Userdefined properties under 

Ifc Parameters.  

 

3. Once assigned, proceed to export it based on the IFC Export Setup Steps (refer to section 5). 
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5.5 HOW-TO REMAP EXISTING PARAMETERS TO MATCH CX SUBMISSION 
PARAMETERS 

One option for the export of IFC files is to remap existing parameters by the userdefined parameter name to 

match in CX Submission Parameters. 

In the Property Set Mapping/ Revit Configuration File, everything between <TAB> is replaced.  

For example, the Userdefined IFC-SG Property name need to be replaced into another parameter name.  

  

1. Find the correct Property Set where the property resides. Without changing the parameter used in 
the model, replace “CompanyName_Mark” after the Property Type with <TAB>, the exported 
parameter that will be replaced. 

  

  

Property Set Mapping/ Revit Configuration File 

  

Sample Revit with Existing Parameter 
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Exported File after property mapping 

  

Source from Autodesk Revit Guide 
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6 Frequently Asked Questions  

Questions  Responses from Autodesk 

In Revit, is it 
ok to create 
2 types of 
categories 
for 
IfcExportAs 
parameters? 
– i.e. As a 
type 
category 
and instance 
category. 
The type 
parameter is 
a project 
parameter. 

It is advisable to keep to 1 type of category for IfcExportAs Parameter.  
Having 2 types of category will not allow both information to be exported as the instance 
category will override the type category parameter.  
It is also advisable to use “instance Category” for IfcExportAs as it allows more flexibility 
and enables users to modify the parameter values separately for every instance.  
Type Parameter on the other hand is associated with the system and object family type. 
When changes are made to this parameter value, it will apply to all the elements of the 
same family type.  

I have family 
that I would 
like to 
prepopulate 
its IFC 
properties 
and sub 
types, how 
can I apply 
IfcObjectTyp
e as Type 
Attributes? 

For advance users who are familiar with modifying Shared Parameter files, please add the 
line below to populate IfcObjectType[Type] property.  

 

PARAM 54f49c86-bf8c-4689-830a-
54bc73fa0ab2                 IfcObjectType[Type]       TEXT                      2              1                
Special Parameter to set the Instance ObjectType attribute from the 
Type             1              0 

How can 
Civil 3D 
elements 
like drain 
and Road 
be exported 
to IFC-SG?  

Road is represented as IfcGeographicElement, whilst Drain, Drainage System, Drainage 
Reserves has different representations in IFC-SG. 
Users can refer to the IFC-SG mapping for the respective IFC representation.  

Additionally, IFC 4.3 for Infra and Railway are under deployment by Building smart and 
Autodesk is working on the integration with Civil3D and Revit. Roadmap info should follow 
by End of 2022.   

 http://ifc43-docs.standards.buildingsmart.org/ 

 

How is the 
project 
boundary 
represented 
in IFC-SG? 
Can lines be 
used 

Project, Site boundaries are represented as a topography in Revit. The revit 
representations can be found on the IFC-SG mapping where users can refer to.   

  

http://ifc43-docs.standards.buildingsmart.org/
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Questions  Responses from Autodesk 

Which version of 
BIM 
interoperability 
tools should I use?  

Users should update & use the latest versions that is available for the respective 
versions of Revit accordingly. Update the apps via Autodesk Desktop App 

Will the federated 
IFC export be 
available on older 
versions of Revit 
2020 or 2021? 

Autodesk is exploring the options. Autodesk has already submitted this as a 
Requirement for 3 versions (internally). This is a big data challenge and would 
require cloud integration so depending on the API 

 

When does one 
need to use 
dynamo when 
assigning IFC-SG 
parameters? Are 
the IFC-SG 
configurator files 
enough? 

Dynamo could support and accelerate the populating of IFC-SG properties in Revit 
– it is an alternative workflow to the BIM Interoperability tools.  

With the use of Dynamo Player, the scripts can be automated for regular Revit 
users to run and populate IFC-SG parameters. 
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Can Revit parts 
(split from walls, 
slabs etc) be 
exported to IFC-
SG? 

1. In Revit, Go to “File” & head to the “Export” tab.  
2. Select “IFC” Option & modify the setup 
3. Access the “Advanced” tab 
4. Check the box that indicates “Export parts as building elements”  
5. Access the “Additional Content” Tab & check the box that indicates “Export 

only elements visible in view” 
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Questions  Responses from Autodesk 

For linked models 
Revit, is it 
recommended to 
export each file 
individually or 
export one time via 
the master model 
files? 

Exporting of the linked files with the master file or exporting the link files as a 
separate IFC would vary depending on the file size & users preference. The larger 
the file sizes are, the amount of time taken will differ.  

For project typical 
units that need to 
be blocked / celled 
and then repeated / 
array / mirrored in 
the main block 
model, is this still 
possible for the 
workflow when 
exporting the Revit 
model to IFC? 

Yes, users can refer to the guides provided for the available options for exporting 
linked files. (See Section 6.1) 

 

Objects set to 
“Demolished” status 
isn’t shown in IFC 
export. 

 

This program behavior corresponds to the current product design of Revit.  

Exporting multiple project phases into one IFC model is not supported in the file 
format IFC 2x3. 

While the IFC4 file format supports this, there is still no related Model View Definition 
(MVD) that would support this workflow. -Autodesk Source 

Refer to 6.2 for localized solution for setting of element status. 

 

  

https://www.autodesk.com/support/technical/article/caas/sfdcarticles/sfdcarticles/Unable-to-export-model-elements-from-multiple-project-phases-to-IFC-from-Revit.html
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6.1 RECOMMENDED APPROACH TO EXPORT LINKED FILES  

Exporting multiple linked files with the host file into a unique IFC file  

Users can export linked files in a project along with the host file to one IFC data file.  
To do so, Users can bind the links in the existing project to the host file.  
The linked files will be merged to the host file, onto which, once exported to IFC, you would be able to 
retrieve the data in one IFC data file along with the linked files in the models merged as one.  

1. Audit, purge the unused models and clean all warnings before starting the binding process. This is 
done to avoid issues when binding a linked model to the host file.  
 

2. Open the current host model and use Save As to make a copy of it. 
 

 
 

3. In the copied file, select each link and choose “Bind Links”. Ensure that none of the options are 
selected in the pop-up dialog box and select OK.  
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4. Select “Yes” to continue to bind link 
 

 
 
 
 
 

5. Select “ok” to duplicate types 
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6. Select “No” to duplicate group types & Unjoin / Disconnect Elements 
 

 
 

7. Remove Links   

 
 

8. Once the links is bind,export the Revit model to IFC accordingly.  
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Exporting linked files with the host file into separate IFC files 

Users can also export linked files in an existing project, with the host file and retrieve separate IFC files 

1. In Revit Interface, Go to “File”, head to the “Export” tab & select “IFC” Option 
 

2. Modify the Setup & access the “Additional Content” tab. 
 

3. Check the box that indicates “Export linked files as separate IFCs” and proceed to export the files 
accordingly. Note that if this function is not selected, the Revit linked files will not be exported 

 
 

4. Once exported, users are advised to check the separated IFC files in an IFC viewer to ensure that it 
has been federated.  
 
Alternatively, Users may refer to the guide on exporting the linked files provided in the FAQ 
answers. 
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6.2 HOW TO SET AND EXPORT ELEMENT STATUS TO IFC 

For submission purposes, do not use the native Revit Phasing tool as it will affect the IFC export. 
 
The alternative proposed method is to load and use the shared parameter “ObjectStatus”, 
populating it with the sample values: “Ëxisting”, “Demolished” or “Proposed”. 
 
 

 
Do not use the native Revit Phasing tool, Use “ObjectStatus”  

 

 

IFC Export 

 

7 Resource Link 

buildingSMART Documentation - IFC 4 Reference View 

Revit IFC Open BIM Manual 

 

  

https://standards.buildingsmart.org/MVD/RELEASE/IFC4/ADD2_TC1/RV1_2/HTML/
https://blogs.autodesk.com/revit/wp-content/uploads/sites/110/2022/02/09/revit-ifc-open-bim-manual-en.pdf
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8 Change Log  

Date  Description   

May 2023 Added FAQ, Predefined Type workflow for Revit 23 and newer 

Nov 2022 Added section for advance users who wish to merge IFC-SG shared parameter into 
company existing shared parameter file 

Oct 2022 Updated Section 4.5 on Property Mapping (Configuration to map existing parameters to 
match Corenet X parameters 

May 2022  Base Version completed   

Aug 2022  Added FAQ  

Feb 2022 Added Preface section and updated screenshots 

 

 


